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Relying on one of Microsoft Word’s included templates to get you up and running with document design can be a big time saver, as everything from dimensions to placeholder text is already done for you. This doesn’t mean you're locked into the template’s look, though. Create your own custom template from one of Word’s templates, such as a
personalized fax cover sheet, by adding your own information lines, graphics and even a confidential message. Launch Microsoft Word. Click the “File” tab. Click “New.” Double-click the “Faxes” button. Scroll through the fax templates and double-click one that will be suitable for your own template. Within a few moments, the template opens in a
new Word window. Highlight the first placeholder text on the fax cover sheet, which may be “Name” or “Sender” - placement of text will vary depending on the template chosen. Type over it with your own name or information. Replace the other template details with information you’ll want to use on your own fax template. To delete placeholder text
on the fax without adding any, highlight the text and press the “Delete” key. Add an image, such as a company logo, to the fax template by clicking the “Insert” tab. Click “Picture.” Browse to the logo and double-click the file name, then drag it into place on the fax, such as in the top center. This is also a way to dress up a fax with seasonal artwork
and designs. This is optional. Give the fax a special message by clicking the “Page Layout” tab. Click the “Watermark” button. Choose the “Draft” or “Confidential” option to add this to the fax template. This is optional. Click the “File” tab. Click “Save As.” Enter a name, such as “Fax Template” in the “File name” box. Click “Save.” Reopen the
template each time you’re ready to fax. Fill out the information on the cover sheet, then resave the document with a new name such as “FaxTemplate10-01-11” so your template is always in its original form and ready to use. Finding a free fax cover sheet template for Microsoft Word® is fairly easy, but Vertex42 provides one of the first fax templates
designed for Excel and Google Sheets. The template makes it easy to customize a printable fax cover sheet for your company. You can also download one of our editable PDF or Word files.Offices typically create a custom blank fax cover sheet and then print multiple copies to place by the fax machine. Because of this, we've designed our fax cover
sheets with plenty of room for writing quick messages. Advertisement The two PDF files below are similar except that the second one includes a place to write the company name. Note that in both it is clear that the # of pages includes the cover sheet as page 1. You can also download these for Microsoft Word. This free Fax Cover Sheet template for
Excel provides a professional and concise format that you can use to create your own personal or company cover sheet. Many offices choose to place multiple copies of a blank cover sheet right by the fax machine, so we've designed this template to have plenty of space to fill in the information by hand. More Free Fax Cover Sheets Fax Covers by
Microsoft - templates.office.com - A few free fax templates available from Microsoft's template gallery. Collection of Fax Cover Sheets - myfax.com - A very large collection of free fax cover sheets that you can browse and download for Microsoft Word. Many different styles and designs. We offer a free printable fax cover sheet template in 16 different
formats. You are free to edit the template to suit your needs. You can add your details and your logo. Fax Cover Sheet Template The information included in each confirmation page: date, number of pages (first page of x pages), intended recipient or recipient’s name, fax number, fax number of the sender, subject line, and space for a short message.
For a business fax cover sheet there is also an option to add a logo and the company’s name, phone number, and other relevant information. Facsimile Cover Sheet Disclaimers When the fax documents are confidential, you might need to add a disclaimer such as this: The facsimile transmittal may contain information that is privileged, confidential, or
exempt from disclosure under applicable law. If the reader of this message is not the intended recipient, you are notified that any review, use, copying, dissemination, or distribution of the contents other than to the addressee of the communication is strictly prohibited. If you received this communication in error, please notify us immediately via the
contact details above and return the original message to us or destroy the attached documents. A fax cover disclaimer should include the following: A statement that the information is privileged, confidential or exempt from disclosure under applicable law; That it is intended for use only by the recipient; That use of the information is strictly
prohibited; Notification to the sender in the event of erroneous receipt The sample disclaimer above includes all four of these elements. How to make a fax cover sheet Select any fax cover sheet example from the selection above. You can select a fax cover sheet PDF format if you prefer to use the blank version. If you want to add your company’s
details, then the Word format will be a better option. You can add your company’s name, address, contact details, logo, etc. If you don’t like any version as-is then select the fax sheet in Word and edit as you wish. If you want to add your logo, then select a fax cover page with a logo and replace it with your own. You can also add a logo to any template,
even if it doesn’t have one. To do this, open the document in Microsoft Word. Click on insert then select the image and select your logo. Right-click on the logo and select “wrap text”. Select “In front of text” and drag the logo to wherever you want it to appear. The free fax cover sheet can be used for your home or your business. If you are using it for
a business, then fill in all the details that will be relevant each time you use it. This includes the sender’s name, contact details, the company’s name, and address. You can then put a few copies next to the fax machine and use it whenever you need one. You will then only need to fill in the recipient’s details. How to make a fax cover letter You can use
the message section to write a fax cover letter. If you want to write a long message, then select a template with more space for a message. How to edit the fax cover sheet template You can edit the free fax cover sheet template with Microsoft Word, Excel, Google Docs, or Google Sheets. Select any fax sheet template from the selection above. If you
want to edit it extensively, then select the fax cover sheet Word version. If not, you can select a typeable PDF version as well. Type your name and contact details if the fax template is for personal use. If you are making a fax cover page for a business, then add your business name, contact details, address, website, email, fax and telephone number,
and logo if you have one. If you are going to fill out everything each time you use the cover page, then save the document somewhere accessible. If you are going to fill out the specific details by hand, then delete all sections that will need to be filled out by hand. Make a few copies of the blank fax cover sheet and put them next to the fax machine.
Each time you send a fax, you can fill in the details. This will save you a lot of time. How to fax without a fax machine There are many online fax services available today so you don’t need a fax machine in order to send or receive a fax. You usually don’t need to add your fax cover sheet to your fax. The online fax service does it for you. You don’t even
need to print it, which makes it more cost-effective. Capture your best moments with our premium photo album templates. DOWNLOAD THE TEMPLATES NOW. Make sure your fax ends up in the hands of your intended recipient. Use a fax cover sheet with all the essential information. It's easy to convert a good Word letterhead template to a fax
template. A fax cover sheet is essential to convey information about the fax. Its purpose is reaching its intended recipient and achieving its communication goal. But why create a fax cover sheet from scratch when you can easily use a Microsoft Word fax sheet template or letterhead template? Start with a high-quality letterhead template. It'll be easy
to convert to an eye-catching fax cover sheet template. In this post, you'll learn where to find some of the best free fax cover sheets for Word. Free Word fax cover sheet templates are fine. But if you want a more professional look, consider the premium Word templates at Envato Elements and GraphicRiver. A premium Word fax cover sheet template
is also the better choice if you want to avoid the watermarks embedded in some free templates. Go Premium for a Professional Look Envato Elements has an irresistible offer. Get unlimited downloads of Word templates and other digital assets for a small monthly subscription. You've got a choice of millions of creative assets, each one with a simple
commercial license giving you broad commercial rights. This means you can use the items for both personal and work projects. Get your premium templates for Word from Envato Elements or GraphicRiver. For the one-off project, look to GraphicRiver as an option. Here you can find premium fax cover sheet templates for Word—and other items for
every creative project—on a pay-as-you-go option. Between Envato Elements and GraphicRiver, you can find all the digital assets you need within your budget. 5 Premium Microsoft Word Fax Cover Sheet Templates (for a Professional Look) To give you an idea of what premium Microsoft Word fax cover sheet templates are available, we’ve rounded up
some templates from Elements and GraphicRiver. Use these for fax cover sheets as well as other business-related materials, such as letterheads and stationery: 1. Word Letterhead With Pop Art Make your fax stand out from a pile of faxes when you use the Word Letterhead with Pop Art template to create a fax cover sheet. This template is
particularly suitable for creative and artistic industries, although it can be adapted to any area. Customize this fully editable template to make it truly your own. Easily change everything from the color scheme to the fonts and text with your own visual branding and information. Aside from Word, this A4-sized template is also compatible with Adobe
Photoshop and Adobe Ilustrator. 2. Simple Letterhead Word Template For a more corporate look, this simple letterhead template for Word makes an appropriate basis for a fax cover. This template can be edited in Microsoft Word, as well as Adobe PhotoShop and Adobe Illustrator. It’s A4-sized, print-ready, and comes with an instruction and help file
from the designer. 3. Branding Letterhead Word Template Your fax cover doesn’t have to be boring, especially if you build it with the Branding Letterhead Word Template. It's got four color options and includes files for editing in Adobe PhotoShop, Illustrator, and Microsoft Word. Add your own logo and edit the shapes, icons, fonts, and more. This
template is in A4 international paper size. 4. Aberdeen Corporate Identity Pack For a consistent, cohesive look, use the Aberdeen Corporate Identity Pack for everything including: stationery invoices envelopes business cards fax covers and more All the pieces in this template pack are fully editable. So, you can smoothly carry your corporate identity
across all your communication documents. 5. Corporate Letterhead With Ms-Word 01 It’s clear why this template pack is popular in GraphicRiver. It's a clean layout and design that can easily be adapted to any industry and corporate use. You can easily use this template to create a neat fax cover sheet. It’s editable in Microsoft Word, Adobe
Illustrator, and PhotoShop. 20 Top Free MS Word Fax Cover Sheet Template Examples to Download (2022) Before looking for a free fax cover sheet for Word template on the web, check Envato's free offerings first. Try out various premium template files (not always [topic]) at no cost to you. Each month Envato Elements offers a different selection of
free files for you to try. you can also find free files each month on GraphicRiver. Here's the deal: Premium Word templates are outstanding to make impressive fax cover sheets. But if you absolutely must use a free template, here are a few to begin your search. 1. Business Fax Cover This non-nonsense template for Word includes all the information
you need to include in a fax cover sheet. 2. Blue Steps Fax Cover This free fax cover sheet template for Word makes a visual statement through a series of blue bars. Aside from critical transmittal information, it also provides space to include your email address, website URL, and other contact information. 3. Purple Graphic Fax Cover This Microsoft
Word fax cover template offers a bold look with diagonal stripes as a background. Change the font and colors to suit your visual branding. 4. Urgent Fax Template 11 This is a no-nonsense fax cover sheet template with plenty of space for a summary of the attached. 5. Urgent Fax Template 14 This free fax cover template was created specifically for
urgent faxes requiring immediate attention. The simple and straightforward design won't distract attention from the urgency of the matter. 6. Confidential Fax Template 10 This is a free fax cover sheet template designed for confidential messages. Space for the most essential information is on top, while the bottom half provides ample space for a
summary. 7. Confidential Fax Template 15 Here’s another free Word template for a fax cover, made specifically for confidential communications. 8. Modern 05 Fax Cover Sheet Template The Modern 05 fax cover template for Word commands attention with a solid arrow on top of the page. A row of dots over the message section adds visual interest.
9. Modern 09 Fax Cover Sheet Template for Word Here’s another free fax cover sheet in Microsoft Word format. The design is modern and readable. 10. Non-profit Fax Sheet Template Designed especially for non-profits this free fax cover sheet features a graphic of paper doll chains. 11. Business 01 MS Word Fax Cover Page This basic fax cover
sheet template offers simplicity and clarity for a variety of business uses. 12. Education Microsoft Word Fax Cover Template For those in the field of education, this free fax cover sheet template for Word is appropriate. The graphic of an apple and graduation cap makes that crystal clear. 13. Basic Printable Fax Cover Sheet for Word As the name
suggests, the Basic Printable Cover Sheet template covers all the essentials of a fax cover. It also includes checkboxes to show whether the fax is urgent and/or if a reply is requested. 14. Blank Cover Sheet Fax Template with Company Name Blank Cover Sheet with Company Name provides a space to type in your company name. The rest of the sheet
allows you to fill in the necessary information, such as the recipient’s name and the total number of pages of the faxed document. 15. Simple Fax Cover Sheet This basic fax cover sheet template features the word “Fax” outlined in large letters. There’s also plenty of space for all the essential information you want to convey. 16. Professional Fax Cover
Sheet Template for Word For corporate faxes, this free fax cover sheet with a globe-like sphere may be used. It also includes checkboxes to indicate the action you want the recipient to take. 17. Tree Fax Cover Sheet for Word For some work or personal uses, this free fax cover sheet may be suitable. It’s accented by a clipart of a tree and grass. 18.
Cursive Large Print MS Word Fax Cover Sheet The large cursive font on this fax cover sheet for Word makes it appropriate for informal communications. 19. Confidential Fax Large Print Fax Cover Sheet This is another free fax cover sheet template for confidential faxes. It includes a Confidentiality Notice at the bottom of the page. 20. Fax Cover
Template for Word Here’s another basic fax cover template for Word that’ll work in any work or personal communications. The bold bar on top gives its simple design a point of emphasis. 5 Quick Tips To Make Great Fax Cover Sheets in Word 2022 No matter which Word fax template you use, there are a few tips to keep in mind to ensure the most
effective and efficient communication. Below are five ways to make awesome fax cover sheets using Microsoft Word: 1. Include the Most Essential Information The purpose of a fax cover sheet is to ensure the rest of the fax reaches your intended recipient. To do this, the fax cover sheet should include the following information: Recipient’s name and
fax number. Especially if you're sending the fax to a large organization, it can easily get lost or ignored if it’s not clear whom the fax is for. Sender’s name and contact information. Also include your company name, fax number, telephone number, and email address so the recipient knows how to respond to you. Total number of pages attached. This
helps the recipient verify that they’ve received all the pages you intended to send. Date and time of transmission. This is particularly important for time-sensitive information. Message. Add a short message or summary of the fax to give proper context. 2. Keep It to One Page The fax cover sheet shouldn’t be more than one page long. Any more than
that, and you’ll be taking the recipient’s attention away from the main communication. Also be mindful that everyone is busy, so cut out anything that isn't essential. Your fax cover sheet shouldn't be longer than one page. 3. Use a High-contrast Design Fax machines are notorious for distorting the transmitted image. Besides, you never know if the
receiver’s machine is running low on toner! Increase your chances of sending a clear fax by choosing a fax cover template with a high contrast and uncluttered design. It should be easy to read and scannable. 4. Stick to Legible Fonts Whichever Word template you choose, use fonts that are simple and legible. A fax cover sheet isn't the right place to
experiment with unusual fonts that make your message hard to read. Stick to conventional fonts with tried-and-true legibility. Simplicity is key. 5. Remember Your Branding Premium Word templates are fully customizable so you can reflect your branding. The fax cover letter is part of your organization’s overall branding. It should be visually coherent
with your other communication and marketing materials. So, choose a fax cover template that allows you to include your company logo, name, and other identifying design elements. By following these tips, you can create a fax cover sheet in Word that achieves its purpose: getting the fax to the right person and achieving the response you need.
Discover More Top Microsoft Word Template Designs Many Microsoft Word template designs are available for all your personal and work projects. To help you find impressive Word templates for your other communication needs, check out these roundups: 20 Best Free Sign In & Out Sheet Word Templates to Download 2022 20 Best Free Professional
MS Word Business Report Templates to Download 2022 Best of 2022: 28+ Microsoft Office Word Document Templates to Download Now 20 Best Free Microsoft Word Corporate Letterhead Templates (Download 2022) Learn More About Making Great Word Documents in 2022 You can create any document you need in Word, for both personal and
work projects. Our MS Word tutorial guide will help you make the most of Word’s powerful features. Here are a few tutorials that go deeper into how to make the most of this feature-rich desktop printing application: How to Quickly Format Basic Text Styles in Microsoft Word Documents How to Make Awesome Page Layout Designs in Microsoft Word
(+Video) How to Change the Default Font in Microsoft Word (+ Best 2020 Font Styles) A Branded, Effective Fax Cover Sheet at Your Fingertips If you're in one of those industries for whom fax machines continue to be indispensable, then create your own branded fax cover sheet. It helps ensure smooth and effective communication. Free and premium
fax cover templates for Word make it easier to create fax covers. Aside from optimizing communication, premium fax cover sheets for Word convey professionalism with their expert designs. You can source premium templates and other creative assets Envato Elements for unlimited downloads. Or grab them from GraphicRiver on a pay-per-use basis.
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